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1. Introduction 

Thank you for choosing the ku-pF Single Place. This manual can help you understand the ku-pF Single 
Place features. 
 
The ku-pF SP is used to determine the unsaturated hydraulic conductivity and the pF curve of soil 

samples in the laboratory. The measurement method is based on the theoretical approach of Schindler 

(1980). 

According to this approach the soil samples of investigation are completely saturated at the beginning 

of the experiment and basal sealed, whereas the top of the samples are exposed to evaporation. In a 

suitable time interval the weight loss due to evaporation is recorded by a balance. The soil samples are 

also equipped with two tensiometers which are horizontally installed at a distance of three 

centimeters. Thus, the hydraulic gradient can be calculated by using the tensiometer readings and the 

vertical distance between both tensiometers.  With the ku-pF apparatus both, disturbed and 

undisturbed soil samples can be examined. The experiment operation and primary data recording is 

performed by an integrated process computer. Communication with the process computer takes place 

via a PC. 

There are several ways to contact UGT if you need a quote or product information please contact 

Email: info@ugt-online.de 

 

For any technical assistance or feedback or in case of problems with your product please contact 

Email: support@ugt-online.de 

 

We look forward to your inquiries or questions and are with pleasure at your disposal. 

Phone: + 49 (0) 33432 – 89 575 

Fax: + 49 (0) 33432 – 89 573 

If contacting us by email or fax, please include as part of your message your instrument serial number, 

your name, address, phone, and a description of your problem or question. 

Please read these instructions before operating your ku-pF Single Place to ensure that it performs to its 

full potential. 
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2. Technical Parameter 

  

Volume / Diameter sample ring 250 cm³ / 41 cm2 

Measurements sample ring ( x H) 7,2 x 6,1 cm 

Cycle time of data acquisition 1 - 4 min 

Resolution of the weighing 0,01 g 

Range of tension measurement 0 - ca. 900 hPa 

Weight of the device ca. 16 kg 

Dimensions device (L x B x H) ca. 30 x 45 x 40 cm 

Power consumption 230V / 1A 

PC-connection Serial Interface (115200 Baud) 

Time of the tensiometer readings Measuring Position1 

Time of the weight measurements in Weighing Position2 

Memory 210 up to 840 days 

 

 

3. Physical Basics 

The hydraulic conductivity in the saturated soil zone can be calculated according to the DARCY 
equation (1).  

𝑸 = −𝒌 ∙ 𝑨 ∙
𝒅𝝍

𝒅𝒛
  ⇒  𝒗 = −𝒌 ∙

𝒅𝝍

𝒅𝒛
                                                                     (1) 

𝒗 =
𝑸

𝑨
                                                                                            (2) 

𝒈𝒓𝒂𝒅 𝝍 =
𝒅𝝍

𝒅𝒛
                                                                                          (3) 

𝒌 = −
𝒗

𝒈𝒓𝒂𝒅 𝝍
                                                                               (4) 

𝒗 specific flow rate (amount of water flowing through a fixed cross-section per unit time)      [cm/s] 

𝑸 Total flow through the soil sample                                                                                                   [cm3/s] 

𝑨 flow cross-section area of the cylinder                                                                                               [cm2] 

𝒌 hydraulic conductivity (permeability coefficient, k-value)                                                             [cm/s] 

𝝍 driving potential for water movement (also hydraulic potential 𝝍𝑯, as sum of matrix potential 

                                                      
1 During the measuring position the sample holder is located on the support arm. Thus, the sample holder is connected to  
   the device and the tension measurements are taken. 
2 The weight is recorded immediately after the tension readings. The balance is moved into the weighing position. 
  Thus, the sample holder is completely separated from the instrument. 

http://www.ugt-online.de/
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𝝍𝒎 and gravitational potential 𝝍𝒛)                                                                                                       [cm] 

𝒛 flow length                                                                                                                                                 [cm] 

𝒈𝒓𝒂𝒅 𝝍 hydraulic gradient of the potential (describes the change of the potential along the flow path)  [-] 

 
In the unsaturated zone, the (unsaturated) hydraulic conductivity is no longer constant, but depends 
on the matrix potential (𝒌(𝝍)). In addition, even under stationary conditions, the hydraulic gradient 
(3) is no longer spatially constant. Therefore, the Schindler (1980) calculation is done by assuming 
quasi-steady flow conditions, which means that 𝒗 and 𝒈𝒓𝒂𝒅 𝝍 are assumed to be constant over a 
specified length of time and flow length. The hydraulic gradient as the sum of matrix and gravitational 
potential is given by equation (5): 
 

𝒈𝒓𝒂𝒅 𝝍 =
𝚫𝝍

∆𝒛
=

𝚫(𝝍𝒎 + 𝝍𝒛)

𝚫𝒛
=

𝚫𝝍𝒎

𝚫𝒛
+

𝚫𝝍𝒛

𝚫𝒛
=

𝚫𝝍𝒎

𝚫𝒛
+ 𝟏 

(1) 

𝚫𝝍 Gradient of the hydraulic potential [-] 

𝚫𝝍𝒎 Gradient of the matrix potential [-] 

𝚫𝝍𝒛 Gradient of the gravitational potential [-] 

𝚫𝒛 Distance between upper To and lower Tu tensiometer (=3 cm) [cm] 

 
The change of the gravitational potential with the z-coordinate corresponds to the unit gradient. The z-
axis is directed upwards. The matrix potential values are negative under unsaturated conditions. The 
gradient of the matrix potential is calculated according to equation (6). 
 

𝚫𝝍𝒎

𝚫𝒛
=

𝝍𝒎𝒐
− 𝝍𝒎𝒖

𝚫𝒛
 

(2) 

𝝍𝒎𝒐
 Tension of upper tensiometer [cm] 

𝝍𝒎𝒖
 Tension of lower tensiometer [cm] 

As a result of the evaporation, a flow velocity 𝒗𝒐 (filter velocity or specific flow) is formed on the free 
sample surface. The basal sealing of the sample causes, as a lower boundary condition, the flow 
velocity 𝒗𝒖= 0. For the sample center between the tensiometer positions, a mean flow velocity can be 
calculated under quasi steady flow conditions: 
 
 

𝒗𝒎 =
𝟏

𝟐
∙ (𝒗𝒐 − 𝒗𝒖) =

𝟏

𝟐
∙ 𝒗𝒐 =

𝟏

𝟐
∙

𝑸

𝑨
=

∆𝑽

𝟐 ∙ 𝑨 ∙ ∆𝒕 
 

(3) 

𝒗𝒎 average flow rate in the middle of the sample [cm/s] 

𝒗𝒐 Flow rate at the top of the sample [cm/s] 

http://www.ugt-online.de/
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𝒗𝒖 Flow rate at the bottom of the sample [cm/s] 

𝑸 Evaporation amount out of the sample per second [cm3/s] 

∆𝑽 During time ∆𝒕  evaporated water volume [cm3] 

∆𝒕 Measuring interval for the soil sample [s] 

Under quasi-stationary conditions, the (unsaturated) hydraulic conductivity 𝒌(𝝍) for the range 
between the tensiometers can be calculated from equations (4), (5), (6) and (7): 
 

𝑘(𝜓) =
∆𝑉

2 ∙ 𝐴 ∙ ∆𝑡 
∙

∆𝑧

𝜓𝑚𝑜
− 𝜓𝑚𝑢

+ 𝜓𝑧
= 𝑣𝑚 ∙ 𝑔𝑟𝑎𝑑 𝜓 

(4) 

𝑘(𝜓) unsaturated hydraulic conductivity as a function of the matrix potential [cm/s] 

The (unsaturated) hydraulic conductivity is a function of the matrix potential and thus also a function 
of the water content. To calculate the water content, the dry weight of the soil sample must be 
determined after the experiment. For the representation of the pF curve (relationship between water 
content and matrix potential), the water content of the sample is assigned to the mean of the two 
tensiometer values for each time intervalΔ𝑡. 
 
  

http://www.ugt-online.de/
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4. Device set up and basic operations  

The single place ku-pF consists of a casing, a support arm for the sample holder and a lift table, where 
the balance is located. The electronic components (power supply unit, transformer, engine with 
controller and logger) are located in the casing. 
The sample holder carries the soil sample and is equipped with two tensiometers and an electronic 
assembly that digitizes the tensiometer values and sends them to the data logger via a two-wire cable. 
The connection to the data logger is made via contacts in the contact cones on the support arm. 
During the evaporation experiment, the tensiometer values are transmitted to the data logger in the 
selected time interval. After that, the balance receives the command to "set to zero". When the 
balance is lifted, the sample holder is disconnected from the support arm and only the weight of the 
soil sample and the sample holder is recorded.  
 
 
 
 
 
 
 
 
 
 
 
  

Support arm with contact 
cones for holding the 
sample holder 

Tensiometer with 
transportation cups 

Sample ring with 
perforated plate 

Power Switch 

Connection for interface cable Connection for calibration cable 

Sample holder with 
base plate 

Precision balance 

Casing 

Lift table 

Emergency switch 

http://www.ugt-online.de/


     

Umwelt-Geräte-Technik GmbH  |  Eberswalder Str. 58  |  D-15374 Müncheberg  |  phone: +49 (0) 33 43 2 - 89 575 |  www.ugt-online.de       Page 8 of 26 

 

 
5. Software and COM-Port Settings 

5.1. First start and ComPort Settings 

 
Install the supplied software by following the installation guide. Connect your computer via the 
connection cable with the ku-pF. When plugging in the USB adapter cable to the computer for the 
first time, Windows automatically searches for a suitable driver (An internet connection might be 
needed. The installation process of the driver can also take some time). 
Open the ku-pF software. A ‘Could not open ComXY!’ may appear on the screen. In this case the 
correct ComPort must be specified within the software. The ComPort is automatically assigned by 
Windows when the USB adapter cable is plugged in and can be looked up in your computer's 
Control Panel. Open the device manager of your computer and open the row: Ports (Com & LPT). 
Under ‘USB Serial Port’ you can see the ComPort number. 
The ComPort of the connection cable is only listed in the Device Manager if the cable is connected 
to the computer and the appropriate USB driver is installed. 

 
 

 

 

 

 

 

Reading the ComPort number in the Device Manager. 

 

Enter the ComPort number in ku-pF Software under Options→ Set com.  

Note, that in some cases high values of the ComPort number can lead to problems when trying to build 
a connection to the ku-pF. In case you encounter some trouble building a connection to the ku-pF 
despite the correct Comport number, rename the Comport number in the Device Manager. We 
recommend selecting a number between 1 and 4.  
 
  

http://www.ugt-online.de/
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5.2. Creating a new project  

Create a new project by either using the icon in the ku-pf software menu or select ‘Project→New’ 
and insert the name of the new project. 

 

 

 

In case of the single place ku-pF only the 
row with the number 1 is of interest. 

Supplementary notes, e.g. sample names, 
site criteria or distinctive features of 
saturation or of the installation of the 

tensiometers can be entered using the  
button. 

The project can be saved and used later by 

pressing  if you do not wish to begin the 
measurements immediately.   

 

 

 

 

 

http://www.ugt-online.de/
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5.3. General information about the software 

The software used for the single place ku-pF is the same as for the multi place ku-pF. By default, the 
sample holder has the number 1 and is therefore also ranked 1st in the software. Sample holders with 
other numbers (2 - 10) are assigned accordingly. Thus sample holders of the multi place version of the 
ku-pF can also be used. The data is stored in a txt-file and is available by default at the following address: 
"C: \ Program Files \ Umwelt-Geräte-Technik GmbH \ kupf-device \ Data". You can close the program at 
any time as the measurements are performed independently by an external computer that is included in 
the ku-pF. 
  

http://www.ugt-online.de/
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6. Preparation  

Before starting the experiment the tensiometers have to be filled and calibrated. 
 

6.1. Filling and Venting of the Tensiometers 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Use the filling and calibration kit supplied with the ku-
pF to fill the tensiometers. In addition, distilled and 
degassed water is required. Before filling the 
tensiometer, the ceramic cup must be saturated. Place 
the ceramic cups in distilled water over night or for at 
least 8 hours. When working with the tensiometer, be 
careful not to touch the cups with bare hands. Use a 
damp paper towel if it is necessary to touch the 
ceramic cup. This prevents blocking of the pores by 
sebum or other deposits. 

Fill the saturated tensiometer tip with distilled and 
degassed water. Use the supplied syringe. Insert the 
syringe into the shaft as far as possible and slowly 
remove the syringe while pushing the water into the 
shaft. 

Take one of the transport tubes with rubber lid and fill 
it with distilled and degassed water. Insert the 
tensiometer tip into the transport tube so that no air 
remains in the tube. 

Take the acrylic adapter and remove the screw. 

http://www.ugt-online.de/
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Cover the screw hole in the tensiometer head with 
your thumb and fill the tensiometer head with water 
using the syringe. Make sure that neither the tip of the 
syringe nor the water jet hit the center of the sensor 
head, because that’s where the pressure sensor is 
located. 

 

Screw the tensiometer shaft into the acrylic adapter. 
To do this, turn the tensiometer head that the screw 
hole points upwards. Leave the screw hole uncovered 
that excess water can escape. 

It is not a problem if water gets lost during this step. 

Take the supplied calibration chamber of the ku-pF 
and carefully remove the tube. 

Screw the small hose with the hose olive (hose clip) 
into the screw opening in the tensiometer head. 

Now connect the small tube on the tensiometer to the 
tube of the calibration chamber. So you can apply a 
vacuum to the tensiometer via the hand pump. Apply 
the highest possible negative pressure (at least 500 
hPa). The vacuum sucks the water from the transport 
tube into the tensiometer. Make sure there is always 
enough water in the tube. If necessary, push the 
tensiometer slightly deeper into the tube to equalize 
the volume. 

http://www.ugt-online.de/
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Attention! 

If permanent air bubbles appear in the tensiometer, check whether the shaft and the 
tensiometer head are screwed tight. Too loose screwing can lead to leaks. 

If there is a permanent drop in pressure or if no water is transported out of the tensiometer, 
check not only the screw connection of the shaft and the tensiometer head, but also the fit of 
the hose clip and the tightness between the hose and the hose clip. If the tightness between 
the hose and hose clip is no longer existent, remove the hose clip from the hose and shorten 
the hose slightly before reinserting the hose clip into the hose. 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

Possible air bubbles in the tensiometer tip are thus 
transported out of the tensiometer. Slightly move the 
tensiometer and lightly tap the shaft to release any air 
bubbles. Then hold the tensiometer with the ceramic 
cup pointing downwards that possible air bubbles rise 
upwards and become visible in the tensiometer head. 
If air bubbles are present, guide them to the screw 
opening by moving the tensiometer accordingly. Thus, 
all air bubbles can be removed and the tensiometer is 
completely filled with water. 

If no air bubbles are visible in the tensiometer, slowly 
release the pressure from the tensiometer. Remove 
the hose clip from the tensiometer. For this it may be 
necessary to first loosen the connection between the 
hose with the clip and the second hose. 

Fill missing water into the tensiometer using the 
syringe. 

Seal the tensiometer. To do this, carefully screw the 
screw into the tensiometer head. 

 

Note: A video tutorial for filling the tensiometer can 
also be found on our website. 

http://www.ugt-online.de/
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6.2. Calibration 

 

For the calibration of the tensiometers use the calibration cable to 
connect the sample holder with the ku-pF. When connecting, care 
must be taken to ensure the correct connection position (red 
marks). 

 

 

 

To calibrate the tensiometers connect the computer with the ku-
pF using the Connect button in the software. Then switch to the 
calibration menu by selecting ‘Work→Calibration’ or the 
Calibration icon in the software menu. 

The current tensiometer readings are shown in the calibration 
menu. In the first calibration step, the zero value is set. 

To set the zero value, hold both tensiometers in a horizontal 
position (with the ceramic cup exposed to air, but completely 
wetted) and press the Zero-Button in the calibration menu. In the 
second step the reference value has to be specified. 

 

 

 

Put both tensiometers into the calibration chamber and secure 
them by using the PG plugs. Lay the chamber and the 
tensiometers down in a horizontal position. 

Apply a vacuum of for example -50 kPa to the calibration 
chamber by using the manual hand pump. Insert the applied 
pressure value into the calibration menu und store the value by 
pressing the Reference-Button. 

 

  To check the calibration, apply a random pressure value to the calibration chamber and compare 
this value with the tensiometer readings shown in the calibration menu. After venting the manual 
pump, the measured value should fall back to 0 kPa.  

Store the prepared tensiometers in the storage cups attached to the sample holder. 

 

 

http://www.ugt-online.de/
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6.3. Checking the zero point drift 

To prevent incorrect measurements, check the zero point drift of the tensiometers after the 
venting and calibration and before installation in the soil samples.  This step can be carried out 
during the saturation of the soil samples (duration approx. 12 hours).  

Place the sample holder without soil a sample on the ku-pF and start a new project.  The 
tensiometers are inserted in the storage cups filled with (bi) distilled water. 

Let the test run for at least 12 hours.  With fully functional tensiometers, the tensiometer readings 
are constant at approximately 0 kPa. 

 

 

  

Tensiometer readings of both 
tensiometers are stable 

http://www.ugt-online.de/
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7. Sample preparation  

When retrieving undisturbed soil samples in the field or when creating disturbed soil samples, it is 
useful to seal the tensiometer holes in the sample rings with adhesive tape. At the beginning of the 
experiment the soil samples have to be saturated. 

To saturate the samples, place the ring with the cutting edge pointing downwards on the perforated 
bottom plate lined with filter paper.  

For saturation, the samples are placed in a water bath. Fill a suitable container up to a water level of 2-
3 cm. Place the samples in the container. Hold the sample slightly tilted when submerged in the water. 
During this process, the holes in the bottom plate can be moistened with the aid of a spray bottle. This, 
and the slightly inclined position, results in the displacement of air bubbles from the holes in the 
bottom plate during settling of the sample. At the beginning the water level should be a little bit higher 
than the top edge of the perforated plate. Raise the water level about a few centimetres every few 
hours. For sandy samples the time interval can be chosen rather small (e.g. raise about 2 cm every 
hour). Clayey soils require much longer time periods. With this procedure the sample is saturated 
without entrapped air in the pore space. The top lid can be removed during the saturation procedure. 
After saturating the sample put the top lid back on. Remove the sample from the water bath and put it 
briefly on a (paper-) towel to remove excess water. 

 

Remove the cover of the boreholes. Use the provided auger to pre-drill the holes for the tensiometer 
installation. To determine the saturated water content, weigh the soil sample together with the top lid 
and the perforated plate. The weights of the top lid, the sample ring, and the bottom plate have to be 
determined individually after the experiment. Place the soil sample with the bottom plate into the 
sample holder and install the tensiometers. Make sure the tensiometers have a sufficient connection 
to the soil. The tensiometers should be pressed in as far as the sealing ring on the tensiometer shaft 
can go.   

Note if the material of the soil samples is prone to collapse, measure the weight of the sample first and 
then pre drill the holes and install the tensiometer.  

Remove the transportation cups from the sample holder (evaporation) before starting the experiment. 

Put the sample holder on the support arm. Remove the top lid after the start of the experiment.  

http://www.ugt-online.de/
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8. Start and run the experiment 

8.1. Start measurements  

Use the  button to connect the software 
to the device if a connection was not already built.  

You may now be informed that an older project is still 
present in the device memory.  Press “NO” to load the 
newly created project in the apparatus memory.  

If you want to open the existing project (here: "Robert 2.kup") from the memory of the 

device, press “YES”.  You can now save this project by pressing .  After saving, press  
to close the already existing object and to disconnect.  

Then open  the newly created project and connect software and device again by 

pressing . 

In the tool menu  select the time interval for the measurements.  Note that the 
evaporation performance can lead to a different duration of the experiment according to 
the soil type.  

o Clay soil (short test duration) – small cycle time  

o Sandy soil (medium to long test duration) – average cycle time 

For the single place version of the ku-pF the time interval can be 1 (10), 2 (20), 3 (30), or 4 
(40) minutes. For a one minute time interval select 10 from the popup menu. 

Start measurements by pressing .  

You will be warned that this will overwrite all stored 
project data.  Confirm with “YES”. 

 

A second warning then appears, reminding you to take 
the tensiometer cups of the out of the baskets.  Click 
on "OK".  The measurements will now begin until they 
are interrupted.  The test time starts at “0” again.  

You can close the program, as the measurements will also be conducted without the PC 
connected.  If you wish to stop the measurements, switch off the ku-pF apparatus on the 
toggle switch. 

http://www.ugt-online.de/
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8.2. Functions 

New  Generates a new project. 

Open  Opens an existing project and provides the corresponding files.  The 
existing data can be viewed in the graph. 

Close  Closes an open project and simultaneously ends the connection to the 
ku-pF. 

Save  Saves the open project.  This has no influence on the files. 

 

Establishes the connection to the ku-pF.  If an ongoing project is running 
in the ku- pF and if no project is open in the software (or if the open 
project does not correspond to the ongoing project), the ongoing 
project is searched for in the current directory and in the standard 
directory.  

If it is present, it is opened on request.  If it is not present, a message 
appears with the following options:  

o To search for the project yourself  

o To generate a new project with the name of the ongoing 
project. 

 
The connection to the ku-pF apparatus is interrupted.  The connection is 
established again by pressing CONNECT. 

 

All data are read out and written onto a file with the name of the 
project name +“000n” and the file extension “TMP”.  If the reading out 
proceeds without fault, the data are then written in the data files 
assigned to the baskets. 

You can view the current readings in the graphs. 

 

Interrupts and ends an ongoing test.  The commands CONTINUE, START, 
CLOCK, CALIBRATION and TOOLS are released.  Only stop when the 
balance moved down. 

 The interrupted experiment is continued. 

 

A new experiment is started with the data from the open project.  The 
start time is saved in the project file and use to display the experiment 
duration. 

 

Clock  The ku-pF clock is set to the time on the PC. 

Calibration  
The ku-pF is switched to calibration mode and the calibration window is 
opened. 
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Tools  The Tools window is opened.   

 

In the main menu three command buttons are available 

 

 

 

Open  

Opens a file to store the read data and enables a separate file to be 
imported in the “.TXT” format.  

Caution: importing causes the existing file to be overwritten. 

Text  
Permits text to be entered for a more detailed description of the 
sample. 

Graph  Displays the data as graph. 

 

Right-clicking on the file name enables the file name (but not the file) to be deleted if the basket is 
not in use.  
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8.3. Graph menu 

Several graph windows can be open at the same time.  If data are being read with open window, 
these will only be displayed after closing the file and opening it again. 

 

Print Prints the graph.  The graph is formatted to the size of the sheet. 

Print install Printer set-up. 

Add/Remove Individual curves can be added to or removed from the graph. 

Calendar The date and time are shown on the X-axis.  If the button is not pressed, the 
test duration is shown on the X-axis. 

Undo Zoom Cancels the enlargement and returns to the levels set in the zoom window. 

Zoom Opens a window to set the display areas. 

Points Shows a small rectangle for each reading. 

Copy Saves a copy of the graph in the clipboard as bitmap or metafile.  From there 
it can be inserted in other programs, e.g. Word. 

The following functions can be executed using the mouse: 

Zoom Click the left mouse button on the top-left corner of the zoom area and hold 
down to drag a rectangle up to the bottom right-hand corner of the desired 
zoom area. 

Undo Zoom Click the left mouse button and hold down to drag a window up and to the 
left. 

Horiz. scrolling Click the right mouse button on the graph and hold down to scroll the graph 
to the left or right. 

Display value Switch points on and click on the desired reading with the left mouse button.  
Time and reading appear in the status bar. 
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8.4. Tools window  

In addition to actuation of the buttons using the 
mouse, the following buttons can be used:  

 

S  Set cycle time  

T  Turn the rotating carrier  

U  Scales up, D scales down  

P  Park position  

ESC  Close window  

 
 

 

Variable sampling rates can be set with the cycle time according to the expected experiment 
duration and depending on the type of soil selected.  

The park position of the scales platform serves as transport protection and should only be applied 
for this purpose.  When putting into operation for the first time, the balance moves to the 
measurement position once the “Lift up” button has been actuated twice.  
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9. Optimisation of the experiment  

The experiment should always be started with covered soil samples.  Under these conditions the flow 
velocity is zero and the pressure difference on the tensiometers is approx. 0.3 kPa. 

After approx. 3 hours, these initial values have been recorded with sufficient statistical reliability.  The 
covers can be removed from the samples.  The mass loss is displayed in the graph menu.  The flow of 
water through the samples begins with the start of evaporation. 

The current test data are displayed during the test in the main menu.  For optimal test control, the 
difference between the water tensions (gradient) in a sample should not exceed a magnitude of 
approx. 5kPa.  This difference can be controlled by varying the current evaporation rate on the sample 
surface.  The sample surface is partially covered by a perforated sheet for this purpose.  When the 
perforated sheet is completely removed, it should be kept on the sample holder and its weight also 
included in the weight record.  

The evaporation protection measures can be seen on the tension curve.  Relevant comments should 
also be entered in the text box as supplementary information. 

 

Clicking on a data point displays the tensiometer, the measurement time and the reading. 

Foil removed at 10:29 AM 
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10. Recording measurement data  

The measurement data can be transferred to the connected PC during the ongoing experiment using 
“READ” and can be presented online.  The graphic depiction always corresponds to the last read-out 
date.  

Establish the connection to the ku-pF by means of "Connect" the current project is loaded and the data 
can be read out.  

The progress of the evaporation can be checked in the graph menu. 

 

 

In the area of the maximum limit of the measurement range, the venting of the tensiometer starts 
(release of dissolved air, expansion of air bubbles).  In the direct vicinity of the tensiometers, the 
increase in water tension is reduced by the release of water.  This reduced increase in the tension 
curve can be explained by the measurement principle of the tensiometers and the low conductivity of 
the samples when discharging the water from the tensiometer. 

Upper limit of measurement 
range reached. 
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11. Evaluation  

For the evaluation of the experimental data the enclosed excel spread sheet can be used (see 
Evaluation kupF SP.xlxs). 

In the first step the raw data should be double checked for measurement errors. Remove all data that 
may contain errors. Insert the checked raw data into the spread sheet in the tab ‘Overview raw data’. 
Use only the data that were recorded after the lid has been removed from the sample and before air 
entered the tensiometers. Insert also the weight of the sample holder, sample ring, bottom plate, and 
the dry weight of the soil. 

The spread sheet displays the entered tension values of both tensiometers and calculates the 
retention curve and the hydraulic conductivity curve based on the entries.  

The retention curve is derived from the mean pressure head and the sample weight at each time step. 

The hydraulic conductivity is derived by inverting Darcy’s law: 

 

𝐾𝑖(ℎ̿𝑖) = −
𝑞𝑖

∆ℎ𝑖
∆𝑧

+1
,                                                               (9) 

whereby 

𝑞𝑖 = 𝑧𝑙 ∙ ∆𝜃𝑖/∆𝑡𝑖                                                                        (10) 

with 

∆𝜃𝑖 = 𝜃𝑖 − 𝜃𝑖−1                                                                       (11) 

∆𝑡𝑖 = 𝑡𝑖 − 𝑡𝑖−1                                                                        (12) 

and 

∆ℎ𝑖 = 0.5 ∙ ((ℎ2
𝑖−1 − ℎ1

𝑖−1) + (ℎ2
𝑖 − ℎ1

𝑖 )) 

ℎ̿𝑖 = 0.25 ∙ (ℎ2
𝑖−1 + ℎ1

𝑖−1 + ℎ2
𝑖 + ℎ1

𝑖 ). 

 

Zl and z represent the distance from the bottom of the sample to the centre between the two 
tensiometers and the distance between both tensiometers, respectively. Both values are 3 cm. 

The meanings of the other variables are listed below: 

Parameter Description 

𝐾𝑖 Hydraulic conductivity 

ℎ̿𝑖 Mean pressure head between two time steps 

∆ℎ𝑖 Mean difference between tensiometer readings 

∆𝜃𝑖 Mean water content change 

𝑞𝑖 Specific flow rate 

 

For the evaluation of the conductivity curve, it is sometimes advisable to carry out the evaluation on the 
basis of data with a coarser temporal resolution, especially when the water fluxes are very small. This 
can be achieved by using only every tenth measured value of the measurement series for the 
evaluation. 
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12. Further Notes 

When handling the ku-pF SP please note the following: 

•  Every tensile load on the data cables must be avoided! 

• It is absolutely essential to avoid any lifting load on the lift table! 

 

• The lift table can be transferred to the measuring position in the "Tools" submenu by pressing 

the "Lift up" button twice. 

 

• Position the ku-pF SP evenly. Align the scale. 

 

•  Before the starting the experiment, make sure that the transport cups for the tensiometers are 

empty or removed from the sample holder. 

 

•  When filling the tensiometers, no water should enter the hand vacuum pump. 

 

• Do not forget to weigh the saturated samples to calculate the saturated water content. 

 

• Check the tensiometer readings from time to time. If the upper tensiometer tends to dry out 

faster than the lower tensiometer, cover the top of the soil sample with a perforated foil. This 

can be an issue especially for sandy soils. In case of sandy soils it is recommended to create an 

environment with a rather small evaporation rate or to cover the soil sample with perforated 

foil. In sandy soil the upper tensiometer tends to dry very fast which leads to a sharp decrease 

in hydraulic conductivity. As a result the soil in the lower part is still very moist, which leads to a 

fairly huge gap between the tensiometer readings. If the difference between both tensiometers 

is too big the assumptions of the evaluation theory are no longer valid and the evaluation 

therefore not trustworthy. Try to avoid a difference higher than 10 kPa. 

 

• Avoid any load on the measuring station during the measurement. 

 

•  Avoid drafts or fluctuations in the room temperature. 

 

•  After the end of the experiment (air inlet in the "top" tensiometer), immediately remove the 

tensiometers from the soil samples and rinse in distilled water.  
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